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INTRODUCTION

MetaSystem apps are designed to work seamlessly with popular Digital Audio
Workstation (DAW) software. These include:

LOGIC X
CUBASE/NUENDO
ABLETON LIVE
DIGITAL PERFORMER
REAPER

STUDIO ONE

The integration between MetaSystem apps and your DAW is made possible through
dedicated plugins, control surface devices, or keybinding files, depending on the
DAW you use. For instance, LOGIC X doesn't require a control surface device, while
CUBASE requires adding a few Generic Remote devices.

In most cases, MetaSystem apps send MIDI CC (Continuous Controller) messages
through configured MIDI ports in MetaServer to trigger specific commands within
your DAW. When you perform an action or tap a button with an application-specific
command, your DAW responds to a MIDI CC command received on the dedicated
MIDI port. This enables MetaSystem apps to control multiple DAWSs, like CUBASE
and ABLETON LIVE, running on the same computer without any routing issues.
Additionally, you can use the METASYSTEM MIDI port to send generic MIDI
messages to your DAW.

To set up integration with your DAW, follow these
steps:
1. Download App Specific Resources:

e Go to www.metasystem.io and download the "App Specific Resources"
package.

2. Configure MIDI Ports in Your DAW:

e Configure the MIDI ports and our custom control surface files in your DAW as
per the instructions in the respective section of this manual or provided in the
downloaded package for your specific DAW.

For Mac Users:



e No additional MIDI setup is needed on Mac. MetaServer automatically creates
the necessary MIDI ports.

For Windows Users:

If you are using MetaSystem apps on a Windows computer and wish to use MIDI
commands or app-specific commands, follow these steps:

1. Install LoopMIDI:

e Download and install LoopMIDI, which is a free virtual MIDI cable software.

Tobias Erichsen N

private stuff & software for audio, midi and more

About Software Contact Privacy Policy -

loopMIDI

download loopMIDI
Virtual loopback MIDI cable for Windows 7 up to Windows 10, 32 and 64 bit.

This software can be used to create virtual loopback MIDI-ports to interconnect applications on Windows that want to
open hardware-MIDI-ports for communication.

The ports created are unigue for each user and only exist while the loopMIDI-application is running. So if you log-off,
the created ports cease to exist.

When you close the configuration, the application will not terminate, but rather be minimized to the traybar. When you
right-click on the traybar-icon of loopMIDI, you get an options-menu to either deactivate the application, configure the
ports or to activate autostart each time you log on to the computer.

This software uses the virtualMIDI driver to actually create the ports.

2. Create Virtual Ports in LoopMIDI:

e Open LoopMIDI and create virtual ports, such as one for Metasystem MIDI
messages and another for your DAW supported by MetaSystem apps (e.g.,
Cubase, Live, or Digital Performer).

e To create a port, enter the port name (e.g., "Metasystem - Cubase" or
"Metasystem - MIDI") and click the plus icon.


https://www.tobias-erichsen.de/software/loopmidi.html

(&) 1oopMIDI

Setup Advanced About
My loopback MIDI ports
Name Total data Throughput /
Metasystem - MIDI - In 0 0 Byte
Metasystem - Cubase - In 0 0 Byte
Metasystem - Studio One - In 0 0 Byte
Metasystem - DP - In 0 0 Byte

New port-name: |loopMIDI Port

3. Configure MIDI Ports in MetaServer:

e Run MetaServer and right-click its icon in the Windows taskbar.

e Select "Setup..." > "MIDI Ports."

e Pair your virtual MIDI ports with MetaSystem app ports for MIDI actions and
each supported DAW or MIDI.

Port Setup
MIDI Mapping

Port name: System device:

Metasystem MIDI

Cubase Microsoft GS Wavetable Synth

Metasystem - MIDI - In
StudioO Metasystem - Cubase - In
p— Metasystem - Studio One - In
Metasystem - DP - In

DP

Cancel

Jimportant info for DIGITAL PERFORMER users:

e Name your port "METASYSTEM - DP - IN" as it is hard-coded into the DP
keybindings file required for MetaSystem app functionality.



[i ] For more detailed information, you can refer to the Windows Setup video tutorial.
This video was produced for MetaGrid Classic, so the visuals may appear outdated.
However, the core concepts remain relevant and applicable.

Menu Command Action

MetaGrid Pro introduces the Menu Command action, allowing you to effortlessly
access menu commands across various Mac applications, including the DAW
applications below and more (ProTools and Reason for example). While this feature
offers extensive customization for Mac users, please note that it is exclusively
available on macOS.

For users on Windows or those who prefer using our preset grids, our default DAW
presets are designed with custom integrations. To set up MetaGrid Pro on Windows
or utilize our preset grids, please follow the specific setup instructions for your DAW.

However, if you're a Mac user, the Menu Command action grants you seamless
access to your DAW's functions, enhancing your creative workflow with ease.


https://youtu.be/zSIjf4vfP10

LOGIC PRO

Logic Pro Commands

With Logic Pro, you're in luck — Logic Pro commands available in the MetaSystem
apps work seamlessly without any additional setup. MetaSystem apps communicate
directly with Logic Pro through Apple Script.

MIDI Transformer Sets for Logic Pro (Premium
Feature)

For users of the premium Logic Pro - Media Composer Grid in MetaGrid Pro, there
are some custom MIDI Transformer Sets created by the MetaSystem team. To use
this grid with your project, you'll need to import these sets. Check out this video for
detailed instructions. For more information, watch this video tutorial.

Art Conductor Integration

For MetaGrid Pro's Art Conductor object to function optimally, you'll need the Art
Conductor articulation set by Babylonwaves and the PlugSearch extension by
Speakerfood. Please note that these components are sold separately. If you need
guidance on setting up this integration, refer to the instructions provided in the
MetaGrid Pro User Guide available through the Settings in MetaGrid Pro and watch
this video tutorial.



https://youtu.be/tJ3CvCrb2Lg
https://youtu.be/RuSntj50vvc

CUBASE/NUENDO

Setting up MetaSystem apps with CUBASE/NUENDO involves several steps, but we'll
break them down for you:

Inside the Cubase folder of the App Specific Resources package, you'll find several
XML files used to create Generic Remote Devices in CUBASE/NUENDO.

Importing XML files to enable app-specific commands
and control.

Here's a quick summary:

e Use Metasystem1.xml and Metasystem2.xml for core Cubase/Nuendo
commands.

e Use Metasystem3.xml for controlling selected track parameters — for
example for our Cubase — Selected Channel preset grid for MetaGrid Pro.

e For custom LE (Logical Edit) and PLE (Project Logical Editor) macros, you'll
need Metasystem_macros.xml and Metasystem_macros2.xml.

Creating Generic Remote Devices:
To create a Generic Remote Device in Cubase/Nuendo, follow these steps:
e Go to Studio > Studio Setup.

. Studio Workspaces Window VSTCI

Audio Connections...

MixConsole

MixConsole 2
MixConsole 3
MixConsole 4
MixConsole in Project Window
Control Room

MIDI Remote Manager
VST Plug-in Manager
VST Instruments
Audio Performance
Video Player
On-Screen Keyboard...

More Options >
Head Tracking
GoPro VR Player Remote




[ ] Studio Setup

Devices

+ Add Device v m e

- Audio System
Built-in Audio
Chord Pads
¥ Chord Pads
MIDI
@ MIDI Port Setup
[ MIDI Remote

Remote Devices (Legacy)

[ Track Quick Controls
M VST Quick Controls

Transport

e Record Time Max

© Time Display
1 video Piayer
P et i . Apsly

Cancel

e Click the +icon in the upper left corner and choose Generic Remote from the
list.

[ ] Studio Setup

Devices

+ Add Device v @EI

Note Expression Input Device -
Time Display

EuCon

JLCooper CS5-10
JLCooper MCS-3000
Mackie Baby HUI

Mackie Control

Mackie HUI

Steinberg Houston
Tascam DM-24 (HUI)
WK-Audio ID

Yamaha 01v

Yamaha 01V96 V2/VCM/i
Yamaha 02R96 V2/VCM
Yamaha DM1000 V2/VCM
Yamaha DM2000 V2/VCM
Yamaha DM2000 V1

Generic Remote

Track Quick Controls
VST Quick Controls Cancel ook

e Click "Import" and import the respective XML file.

Jimportant: For Metasystem1.xml and Metasystem2.xml, set MIDI INPUT/OUTPUT
ports as METASYSTEM - CUBASE - IN/OUT (Mac) or the port you've created in
LoopMIDI for Cubase (Windows).



Jimportant: For Metasystem3.xml, set the ports as METASYSTEM - MIDI - IN/OUT
and METASYSTEM - MIDI - IN/OUT. This file handles selected channel commands
(volume, pan) and supports bi-directional communication.

To sum up, you if you want to take advantage of full Cubase integration you need 5
Generic Remote devices. Here are the corresponding setup screenshots:

1. Metasystem1.xml

LJ Studio Setup
Devices Generic Remote
+ Add Device v ‘.] 2
. .
A Audo System Z Legacy Information
Bult-n Audio The Setup pr this page will be Please use MID| Remote in the lower zone of the Project window.
F Chord Pads MIDI Input Metasystem - Cubase - In v
MIDI Output Metasystem - Cubase - Out v
MIDI Port Setup. .
@ Control Name  MIDI Status MIDI Chann Address Max. Valu Flags | import |
@ B omcnn 1 Controlier 1 27 R >
ontrolier 1 127
Bt |
H Controlier 1 2 127 R..
3 Controlier 1 3 127 R.. o A
4 Controller 1 4 127 R.. Lo |
L e 5 [ 1 5 127 (36 O Leam
Gareric Remate
® 4 6 Controller 1 6 127 Byvs
® ® 7 Controller 1 7 127 R..
B ek ek e ] Controler 1 8 127 R..
{1 VST Quick Controls.
© Record Time Max
© Time Display
I video Player
) VST System Link
Aoy |

2. Metasystem2.xml

° Studio Setup
Devices Generic Remote 2
+ Add Device v @:]
P Z Legacy Information
Buitin Audio The on this page will be inued. Please use MIDI Remote in the iower zone of the Project window.
ZF Chord Pads MIDI Input Metasystem - Cubase - In ¥

MIDI Output Metasystem - Cubase - Oul v
Control Name  MIDI Status MIDI Chann Address Max. Valu Flags Import |

@ Froor Tems M 1012 Command Arranger T p— ' I
© Troe Cioley 103 Command Arranger Trigger Aranger P s |
1014 Command Arranger Trigger Aranger P Delete
LI o Pier 1015 Command Arranger Trigger Amanger P
Lab s L 1018 Command Arranger Trigger Amanger P
107 Command Arranger Trigger Amanger P
i -~ " A -
Resat Apply




3. Metasystem3.xml

L] Studio Setup
Devices Generic Remote 3
+ Add Device v oo
- % Legacy Information
Built-in Audio The Setup provided on this page will be discontinued. Please use MIDI Remate in the lower zone of the Project window.
F CroaPads MIDI Input Metasystem - MID{ - In ¥
MIDI Output Metasystem - MIDI - Out ¥
LT Control Name MIDI Grann_Address _Max. Valu Flags | =
[T MiDi Remote
Pan Gantrolier 10 7 27 RT. | ‘ ==
) Volume Reset  Controlier 10 18 127 AT Cee
8 Geoers rumote 2 Insert Bypass  Controlier 10 19 127 AT, [ Deiate
Record Enable  Controller 10 20 27 RT., [ Learn
e Mute Gontroller 1 21 127 AT.
s Salo Controller 10 22 127 RT.
e Write Controlier 10 23 127 RT. §
[T VST Quick Controls
Control Neme  Device ChannelCateg. Vaus/Action  Fiags o
S VST Mixer Selected Standard Panner .. I‘ feane
IR VST Mixer Selected Volume . ‘ Add
VST Mixer Selected Ins. Bypass ‘ Deiete
L oo Py VST Mixer Selected Record Enable .,
LRIl VST Mixer Selected Mute 5
VST Mixer Selected Solo "
L
[ Aoy
Cancel ok

4. Metasystem_macros.xml

. Studio Setup
Devices Generic Remote 4
+ Add Device v W
A Aurto Syt Z Legacy Information
Buitt-n Audio The Setup provided on this page will be discontinued. Please use MIDI Remote in the lower zone of the Project window.
F Chowd Pads. MIDI Input Metasystem - Cubase - In v
L MIDI Output Metasystem - Gubase - Out ¥
@ DI Port Setup
Control Name  MIDI Status MIDI Chann Address Max. Valu Flags Import |
) MIDI Remote -
F = Export
) Generic Remote N
® : 10 14 127 R.. Delete. |
() aerara Ferscae 10 15 127 R.. O eam
10 16 127 R..
(8 e ke ¢ 10 17 127 R..
08 Pack otk Cemin 10 18 127 R., @8
M vsT Quick Controls
Channel/Categ Value/Acton  Flags
e Time Max Not Assigned l
Wiy Not Assigned ol |
Not Assigned Delete. |
Video Player
L Not Assigned
VST System Link
2 . Not Assigned
Not Assigned

‘Cancel

Apply




5. Metasystem_macros2.xml

° Studio Setup

Devices Generic Remote 5
+ Add Devic v [EIE
4 Autio Syt Z Legacy Information
Buit-in Audio The Setup provided on this page wil be discontinued. Please use MIDI Remote in the lower zone of the Project window.
= Chord Pads MIDI Input Metasystem - Cubase - In ¥
MIDI Output Metasystem - Cubase - Out v

Control Name  MIDI Status. MIDI Chann Address Max. Valu Flags

[ MiD! Remote A EEpl
Macro 202 [ " 102 127 R..

M e Macro 203 Controller 1" 103 127 R.. g

LTI Maco204  Controller 1" 108 127 R... Delete

wleAnm Maco205  Controller 1 105 127 R O Learn

e Maco206  Gontroller 11 106 127 R...

Mm Macro 207 Controller " 107 127 R..

m B Macro 208 Controller " 108 127 R.. -

e Conlrol Name _ Device ChannelCateg _Value/Action _Flags MS - Macros 2 ¥

Macro 202 Not Assigned
Macro 203 Not Assigned
Macro 204 Not Assigned
Macro 205 Not Assigned
Macro 206 Not Assigned
Macro 207 Not Assigned

Avoiding MIDI Feedback:

To prevent MIDI feedback, exclude Metasystem's MIDI input port from the MIDI ports
visible in the All MIDI Input group in Cubase.

Here's how:

e Go to Studio > Studio Setup > MIDI Port Setup (under MIDI folder).

e Uncheck the checkbox in the "In All MIDI Inputs” column that corresponds to
Metasystem - CUBASE - In (Mac) or the port you've created in LoopMIDI for
Cubase (Windows).

e Ensure you don't exclude Metasystem - MIDI - In or the port you've created in
LoopMIDI for Metasystem MIDI if you want to receive actions with MIDI
messages.



® Studio Setup

Devices MIDI Port Setup
+ Add Device \/ m l«l /0 Port System Name Show As Visible State In'AllMID Usage
N ] Metasystem - Ableton Live - In  Metasystem - Ableton Lir Active D A
W Audio System
In  Metasystem - Cubase - In Metasystem - Cubase - | M Active O
Built-in Audio
N Metasystem - DP - In Metasystem - DP - In M aAtve O
In Metasystem - Logic - In Metasystem - Logic - In M Active E]
¥ Chord Pads
v In  Metasystem - MIDI - In Metasystem - MIDI - In Active |
o 3} Metasystem - Reaper - In Metasystem - Reaper - Ir M Active D
[ s
] Metasystem - StudioOne - In  Metasystem - StudioOne E Active D
[ MIDI Remote
S s ] PlugSearch PlugSearch Active M
@ Generic Remote
Out Metasystem - Ableton Live - Ou Metasystem - Ableton Lir M Active
[ Generic Remote 2
Out Metasystem - Cubase - Out Metasystem - Cubase - ( M Active
@ Generic Remote 3
Out Metasystem - DP - Out Metasystem - DP - Out M Active
[ Generic Remote 4
Out Metasystem - Logic - Out Metasystem - Logic - Ou M Active
[ Generic Remote 5
Out Metasystem - MIDI - Out Metasystem - MIDI - Out [¥]  Active %
[ Track Quick Controls < 5
[ vsT Quick Controls
v l Reset l Apply ‘

Cancel ok

Jimportant: If you experience some unexpected behaviours with bidirectional
communication with our Cubase Selected Channel grid, disable also MetaSystem -
MIDI - In port in the “All MIDI” column. However, this will make it impossible for
Cubase to register standard MIDI messages sent through Metasystem — MIDI port
on the selected track (MIDI CCs from faders for example). This inconvenience will be
solved soon with the dedicated Cubase port for bi-directional communication.

LE Macros

Setting Up LE Macros from App Specific Resources

Follow these steps to configure and utilize the Logical Editor (LE) macros provided in
the App Specific Resources for Cubase:

Step 1. Open Cubase and Select a MIDI Part:
e Launch Cubase and select a MIDI part within your project.
Step 2. Access the Logical Editor Setup:

e In Cubase, click on "MIDI," then navigate to "Logical Editor," and select "Setup."



dio MIDI Scores Media Transport Studio Workspa

Open Key Editor

Open Score Editor

Open Drum Editor

Open List Editor

! Open In-Place Editor S

3. Set up Editor Preferences °
Transpose Setup...
Merge MIDI in Loop...
Freeze MIDI Modifiers

Jistc

Repeat Loop |
Functions > ‘

ly Preset...
Drum Map Setup... Apply

Insert Velocities...
CC Automation Setup...

foca

Note Expression >

Expression Map Setup...
els

put¢ Reset

Step 3. Display User Preset Location:

e Within the Logical Editor Setup window, locate the "Presets" list.

e Expand the list to reveal all options, including "Show User Preset Location..."

Preset No Preset
Event Target Filters ‘ O Search:
( Filter Target

( Type Is
S

b Factory Presets

Show User Presets Location...
Event Transform Act
Action Target
Value 1
ﬁ All Events matching Filter Condition using the action list

¥ | Enter Description

I Insert | Remove I
Parameter 2 Bar Range/Time Bas ) Bool
)
[ Insert | Remove ]
Parameter 2 -
D
Transform v ‘ I Apply

V. u. u. v —




Step 4. Access File Manager:

e Select "Show User Preset Location..." to open the file manager, revealing the
location of the user preset XML files.

Step 5. Create a MetaGrid Folder:
e Inside the "Earlier Presets" folder, create a new folder named "MetaGrid."
Step 6. Copy XML Files:

e From the App Specific Resources/Cubase/Logical Edit folder, copy the XML
files associated with MetaGrid to the "MetaGrid" folder you've just created.

< MetaGrid Pro B = R B-0 O O~ v Q
d i Cubase 3 ® MIDI Remote ™ Logical Edit » ™ MetaGrid Pro » R MGO000_Velocity_-1.xml
I Nuendo ™ User Presets > W Pattern Arp B MG001_Velocity_-2.xmi
I Project Logical Editor R MG002_Velocity_-5.xml

R MG003_Velocity_-10.xml
R MG004_Velocity_+1.xml
B MG005_Velocity_+2.xml
If R MG00B_Velocity_+5.xml
B MGO007 Velocity_+10.xml
R MGO00B_Velocity_fixed_11.xml
B MG009_Velocity_fixed_21.xml
t B MG010_Velocity_fixed_31.xml
B MGO11_Velocity_fixed_a1.xml
R MG012_Velocity_fixed_51.xml
B MG013_Velocity._fixed_61.xml
R MG014_Velocity_fixed_71.xml
B MG015_Velocity._fixed_81.xml

& iCloud Drive > Ml Documents » M Steinberg » [l Cubase > [l User Presets > [l Logical Edit > Ml MetaGrid Pro

Step 7. Restart Cubase:

e To activate the MetaGrid LE scripts in the Logical Editor of Cubase, restart
Cubase.

Following these steps, you'll have successfully set up and integrated the provided LE
macros from the App Specific Resources into Cubase. This will enhance your
workflow and provide you with valuable tools for your music production needs.

Assigning an LE Macro to a Button:

To assign a Logical Editor (LE) macro to a button for streamlined workflow in
Cubase, follow these steps:

Step 1. Create a Macro for a Button:

e Begin by creating a macro for a specific button in MetaGrid Pro by adding a
Cubase action to it.

Step 2. Access the LE Macros Category:

e Within the Categories section, scroll through the available options until you
find "MetaGrid: LE macros."



e From this category, select the LE macro that you wish to trigger within
Cubase.

] Note: These LE macros are supported by the "metasystem2.xml" files, which are
configured on the "Metasystem - Cubase - In/Out" MIDI ports.

Ensuring Consistency Between Generic Remote and App-Specific
Commands

When you modify the name of an item in the Generic Remote file, such as changing it
from "Macro 001" to "Repeat Record," it's important to ensure that this change is
accurately reflected in the list of app-specific commands within Metasystem apps.
Here's how to do it:

Step 1. Specify Paths in Metaserver:

e To enable this functionality, you need to specify the paths to
"Metasystem_macros.xml" and "Metasystem_macros2.xml" within
MetaServer.

@ Metaserver : Setup

MIDI Ports ' Files Network Settings Key Shortcuts

Cubase

(. [Users/metasystem/Docume...ase/metasystem_macros.xml

[Users/metasystem/Docume...se/metasystem_macros2.xml

Dorico

D [Users/metasystem/Library/...ico 3/keycommands_en.json

Custom icons

[Users/metasystem/Dropbox/MG_custom_icons

Done

Step 2. Updating Macro Names:



e Open the Metasystem — Macros or Metasystem — Macros 2 Generic Remote
device in Cubase by selecting Studio > Studio Setup and choosing the

respective item.

[ ] Studio Setup
Devices Generic Remote 4
+ Add Device vl e
- .
e Audio System Z Legacy Information
Built-in Audio The Setup provided on this page will be discontinued. Please use MIDI Remote in the lower zone of the Project window.
Pads
F Chord Pads MIDI Input Metasystem - Cubase - In ¥
MIDI Output Metasystem - Cubase - Out ¥
@ MIDI Port Setup
Control Name ~ MIDI Status MIDI Chann Address Max. Valur Flags Import |
[ MIDI Remote ) | —
Macro 001 Controller 10 11 127 74
Re : [ Export |
Macro 002 Controller 10 12 127 R.
o o Macro 003 Controller 10 13 127 R [ Add |
Generic Remote 2
9 Berrc Bt Macro 004  Controller 10 14 127 R.. I Delete |
Generic Remote 3
P o Macro 005 Controller 10 15 127 R.. [ team
m Generic Remote 4
Macro 006 Controller 10 16 127 R,
@ Generic Remote 5
Macro 007 Controller 10 1! 127 R,
[ Track Quick Controls
Macro 008 Controller 10 18 127 R.. ~
[ vsT Quick Controls
Control Name  Device Channel/Categ Value/Action  Flags MS - Macros ¥
ansport ~
Macro 001 Not Assigned e
@ Record Time Max - I Rename |
Macro 002 Not Assigned ———
Time Di Add
| e Macro 003 Not Assigned I |
Video
Macro 004 Not Assigned I Delete |
L7 video Piayer

L] vsT System Link

Macro 005 Not Assigned
Macro 006 Not Assigned
Macro 007 Not Assigned

_ nnn R

R
Reset Apply |

[ ook

e Select Macro<macro number> item and in the Device column tap Not
Assigned in the Device Name and select Command.

e Inthe Channel/Category select Processs Project Logical Editor.
¢ Inthe Value/Action column select your custom LE macro.

Jimportant: All LE macros provided by MetaSystem team are already assigned in
Metasystem 2.xml file. This procedure refers to your custom LE macros.




Studio Setup

Devices

+ Add Device v

e Audlo System
Buit-in Audio

i‘;ﬂﬂP—h
@ Mo Port Setup.
% mioi Remote

i
{0 Generic Remote 2
[ Generic Remote 3

Generic Remote 4

Z Legacy Information

The Setup provided on this page will be dis Please use MIDI
MIDI Input Metasystem - Cubase - In v
MIDI Quiput Metasystem - Gubase - Out ¥

Control Name  MIDI Status

MIDI Chann  Address Max. Valu Flags
-

the lower zone of the Project window.

Macro 004 Controller 10
Macro 005 Controller 10
Macro 006 Controller 10
Macro 007 Controller 10

R,
R..

Ry

o

R. [ Leam
R..

Ryyy

R

Process Project Logical Ef

Scene PLE Macros

Add Date to Selectad MIDI + Audio Track Na:
Append ' 10 Selected Track Names
Append Time to Names of Selected Events o
Collapse All Visible Folders
Colorize Small MIDI parts

Connact Selected Audio Tracks to Stereo Ou
Copy All Data on Selected Tracks befors Cur
Copy All Data on Selected Tracks beyond Cu
Copy All Data on Selected Tracks inside Cyc!
Creata Random Detuna per Note

Creats Random Pan per Note

Decrease Volume of Selected Track by 108 i
Delats All Automation Data of Selectad Auic
Delets All Automation Data of Selected Audic
Delste All Automation Data of Selected Track
Delets All Automation of Selected Audio, Inst
Delete All Automation of Selected Track after

Setting Up PLE Macros from App Specific Resources

In Cubase, go to Project > Project Logical Editor > Setup and expand the
Preset drop down list.

The App-Specific Resources package for Cubase includes tailored Project Logical
Editor macros, allowing you to display different track folders in your project. These
are accessible via the dedicated Cubase action within MetaSystem apps.




[. [ ] Project Logical Editor }

Preset No Preset ¥ | Enter Description

Event Target Filters O Search: ' [ﬁ [ Insert I Remove I

( Filter Target Parameter 2 Bar Range/Time Bas ) Bool

( Media Type is
S

Show User Presets Location...

Event Transform Act [ Insert | Remove I

Action Target Parameter 2
Track Operation

» Pre & Post Commands

I Perform the actions on all events matching the filter conditions Transform v Apply ] ‘

e Click Show User Presets Location to display the default location for PLE files.

e Copy the provided PLE files from the Project Logical Editor in the App Specific
Resources package for Cubase.

e Open the Project Logic Editor again. Now you should see the User Presets
category with MetaGrid folder containing various PLE macros.

Jimportant: These macros correspond to the items in the MetaGrid Scenes category
in the Cubase action selector. You don't need to assign them in the Generic Remote
files — they are already handled by Metasystem2.xml.

Customizing Scene Macros

Our Scene Macros are provided as templates that need to be customized for your
project. Let's say you want to have a button that shows only the tracks in the Vocals
track folder in your Cubase project.

Step 1: Open the PLE Editor
e Click Project > Project Logical Editor > Setup
Step 2: Select the Scene Macro

e Expand the Preset drop down list, expand User Presets and select Scene001.



[. L) Project Logical Editor

Preset Scene001 ¥ | Enter Description
Event Target Filters Insert | Remove \
( Filter Target Condition Parameter 1 Parameter 2 Bar Range/Time Bas ) Bool
( Container Type is Equal Folder Track And
Name Equal --- your folder --- )
Event Transform Actions Insert I Remove ‘
Action Target Operation Parameter 1 Parameter 2
Track Operation Hide Track Disable

» Pre & Post Commands

[ Perform the actions on all events matching the filter conditions Transform v Apply ‘

Step 3: Modify the macro

e Change “- your folder --" to “Vocals”
e Click Apply.

This macro will show the tracks in the Vocals folder.



Step 4: Triggering the macro

e In a MetaSystem app create a button or a gesture with the macro containing
the Cubase action. In the Cubase Action screen navigate to the MetaGrid:
Scenes category and select Scene001.

Q > CuBASE
Category Command

Inspector ke AR

MIDI - Unfold All Visible
MIDI Remote Scene001

Macro Scene002

Marker Scene003

Media Scene004

Media Inspector Scene005

Media List Scene006
Metagrid: LE Macros Scene007
Metagrid: Scenes Scene008
Metagrid: User Macros Scene009
MixConsole History Scene010
MixConsole Snapshots Scene011

Mixer Scene012
Navigate Scene013

Note Expression Scene014

Nudge Scene015

Preset
Scene016

Process
Scene017

e Tap the button or perform a gesture to trigger the Scene001 macro to show
the tracks inside the Vocals folder.

If you want to show only the tracks within the Vocals folder and hide all other tracks,
add the Hide All command to the macro proceeded with a short pause.

)
=
(. Hide All
0.40s
(. Scene001



More information

MetaGrid Classic:

MetaGrid Pro: Cubase MIDI Grid Video Tutorial

MetaGrid Pro: Cubase Selected Chanel Grid Video Tutorial

MetaGrid Classic:

Setup: Cubase Video Tutorial

Showcase: Cubase Video

Cubase LE Macros Video Tutorial



https://youtu.be/hmBcryYGm-k?si=ZiRLI_gRiv1Nbo3E
https://youtu.be/ZfNdtwZrrpI?si=cSM99V_WD8nZEVfb
https://youtu.be/A437weARNkc?si=rahuXtiKe_uzCrQY
https://youtu.be/NPYsg2eRqg4?si=uCaG9QBqEIc4_nmB
https://youtu.be/JbM-imNdimg

STUDIO ONE

Menu Commands (Mac Only)

In MetaGrid Pro, our specialized ‘'Menu Commands' action gives you direct access to
every menu command in Studio One on Mac—no keyboard shortcuts needed. Simply
create a button, assign it a macro with the 'Menu Command' action, choose the
desired Menu and Command, and you're all set!

Studio One 1 am v
L | ]
¥ My Grid for Studio O 1 e
MENU COMMAND (Studio One) Refresh
Category Command
Studio One Instrument Parts >
File
Rename Events...
Edit
Send to Back
Song
Send to Front
Track
2 Mute Events
e Toggle Mute ®

- Transport

View

Unmute Events

Help Add Arranger Section from Selection
Bounce Selection

Bounce To New Track

Mixdown Selection

Export Selection...

Merge Events

Select in Pool

Split at Grid

Spot...

Move To Origin

Custom User Device

To seamlessly integrate MetaSystem with Studio One through the custom user
device created by the MetaSystem team, follow these straightforward steps:

Access Support Files:

e Locate the "Studio One" folder within the package. This folder contains all the
necessary support files for Studio One.



Copy Support Files:

In FINDER (Mac) or File Explorer (Windows), copy the contents of the "User Devices "
folder to the following directories:

e MAC: Copy the content to /Users/<user name>/Library/Application
Support/PreSonus Software/Studio One 6/User Devices

e Windows: Copy the content to /Users/<user
name>/AppData/Roaming/PreSonus/Studio One X/User Devices

3 metasystem > Library > Application Support > PreSonus > Studio One 6 > User Devices > metasystem

B metasystem > 128.png
B metasystem.device
MetaSystem.png
R metasystem.surface.xml
R metasystem.txt
MetaSystem@2x.png

Configure Studio One:
Now, within Studio One:
Step 1: Open Options Window:

¢ Navigate to the Options window within Studio One.

Step 2: Access External Device Tab:

e Inthe Options window, go to the "External Device" tab.

Add... Edn.. Remove  Placement... Reconnect..

v Notify me if Gevices are unavailable when Studio One starts

Step 3: Add Metasystem:



e Click the "Add..." button and browse to the Metasystem.io folder.

[ ] ® Add Device
Wl New Keyboard *  Device Model MetaSystem MetaGrid
New Instrument
New Control Surface Manufacturer MetaSystem
» B Access Device Name MetaGrid
» B Acorn Instruments
e " o mimgmmMees
» B Behringer O apps for iPad andl should
ot > Studio One MIDI P el
» B Doepfer @ by MetaServer application.
rm E-MU
» m Edirol
A MIDI Channels Al
N (Evortion 112874 56 7 (89 1011 12 13 14 15 {16
» m Expressive E
» 88 Frontier Receive From None v
» m JLCooper Filter Aftertouch
» I Keyfax Program Change
»m KORG Pitch Bend
» B M-Audio Controllers
» B Mackie Send To None -
4w MetaSystem
DO | spitCrames
» Im Native Instruments et INataTer DUt
> Pearl
» m Peavey Enable MPE Pitch Range
» m PreSonus
»m ROLI Send MIDI Clock
» 8 Sensel Use MIDI Clock Start
» B Steinberg = Send MIDI Timecode
4  ——— » (

Step 4: Select Metasystem:
e Choose the "MetaGrid".
Step 5: Set Ports:

e Set the "Receive From" and "Send To" options to "Metasystem - Studio One -
In/Out" (Mac) or the port you've created in LoopMIDI for Studio One
(Windows).



@ ® Preferences

General Locations Advanced
Name Send To Receive From ckil|ie i 4
m MetaGrid Metasystem - StudioOne - Out  Metasystem - StudioOne - In
MetaSystem MetaGrid CH: All
v
< »
Add... Edit... R Plag Reconnect...

v Notify me if devices are unavailable when Studio One starts

_ Song Setup Cancel oK

e Click OK. Now Studio One can communicate with MetaSystem apps.

More information:

MetaGrid Pro:

Studio One Project/MIDI Editor Grids Video Tutorial

MetaGrid Classic:

Setup: Studio One Video Tutorial



https://youtu.be/DquHnnxMOjc
https://youtu.be/pPz6UKUjAzw

DIGITAL PERFORMER

Menu Commands (Mac Only)

In MetaGrid Pro, our specialized ‘'Menu Commands' action gives you direct access to
every menu command in Digital Performer on Mac—no keyboard shortcuts needed.
Simply create a button, assign it a macro with the 'Menu Command' action, choose
the desired Menu and Command, and you're all set!

¢~ Digital Performer =

¥ My Grid for Digital Perfor i c J
MENU COMMAND (Digital Performer) Refresh
Category Command

Digital Performer Transpose...
File Quantize...
Edit Groove Quantize...
View Create Groove...
Region Smart Quantize...
Audio Humanize...
Project .
Studio De-Flam...
ot Change Velocity...
Text Change Duration...
Window Split Notes...

’ Help Invert Pitch...

Change MIDI Channel
Set Articulation

Apply MIDI Plug-in >

Insert Continuous Data...
Thin Continuous Data...
Change Continuous Data...

Reassign Continuous Data...

Custom Integration

To integrate a MetaSystem app with Digital Performer (DP) through the dedicated
Key Bindings file (if you are on Windows or you are using MetaGrid Classic), follow
these simple steps:



Locating Key Bindings File:

e Inside the package, you'll find a folder named "DP/Key Bindings" that contains
the dedicated key bindings file required for DP.

Importing Key Bindings in DP:
In Digital Performer:
Step 1: Access Commands Setup:

e Navigate to the "Setup” menu and choose "Commands.’

Setup Text Window Help

Run Command...

Input Filter...

Event Chasing...

Automation Setup...

Legend...

Time Formats 3T

Frame Rate >
Receive Sync...

Transmit Sync...

Slave To External Sync ¥ 7

Open Audio MIDI Setup...
Interapplication MIDI...
Control Surface Setup...

Live Performance Mode

Audio System >
_ Configure Audio System > A
Audio System Clock >

Step 2: Import Key Bindings:

e Inthe Commands window, locate the Mini Menu in the upper right corner and
choose "Import Key Bindings..."



Step 3: Select the File:

e Navigate to the location where you saved Metagrid's app-specific files and
select the "Metasystem_DP_key_bindings.dpkeybind" file.

Step 4: Confirm Import:

e The Binding Conflict dialog will appear. Click Both.
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The "Metasystem_DP_key_bindings" file didn’t not overwrite any default DP keyboard
shortcuts. Instead, it has added MIDI assignments for each available command,
which are managed by Metaserver's "Metasystem - DP - In" port.

Using Layouts:

DP's predefined viewset includes a "Layouts" scene with 40 buttons named "Layout
1" through "Layout 40."

DP typically does not offer layout selection commands by default. However,
MetaGrid introduces a dedicated command category called "Layouts" with pre-

assigned MIDI messages that can be used for assignment in the Commands
window.

This feature is especially handy for frequently used project templates, allowing you
to easily assign layout buttons to layouts you create in DP.



Checking MIDI Masters:

e Ensure that all items in the "MIDI Masters" section within the Commands
window are checked. This ensures that MetaSystem can effectively control
DP.
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More Information

MetaGrid Classic:

Digital Performer — Showcase Video Tutorial

Although this video has been created for MetaGrid Classic, the basic concepts and
DP setup still apply to MetaGrid Pro.


https://youtu.be/X9z4A8J4FYI

REAPER

Menu Commands (Mac Only)

In MetaGrid Pro, our specialized 'Menu Commands' action gives you direct access to
every menu command in Reaper on Mac—no keyboard shortcuts needed. Simply
create a button, assign it a macro with the 'Menu Command' action, choose the
desired Menu and Command, and you're all set!

Y REAPER " »
¥ My Grid for RE F ayout ne
MENU COMMAND (REAPER) Refresh
Category Command
REAPER Media file...
File New MIDI item
Edit Empty item .
View

SMPTE LTC/MTC Timecode Generator
Insert

Click source
Item
ucas New subproject .
Options
Actions Marker
Window Marker (prompt for name)
Help Region (from time selection)
= [16kHz 24bit WAV : 1/1ch 512spls ‘empojtime signature change marker
~42[42ms]

Measure from time selection
(detect tempo)

Measure from time selection (new time

signature)...

Track
Multiple tracks...

Virtual instrument on new track...

Custom Actions

Enabling MetaSystem apps' support for custom actions in Reaper is a
straightforward process. Here's how to do it:

Step 1. Access Reaper Preferences:
e In Reaper, go to "Reaper Preferences."

Step 2. Configure MIDI Port:



e Click on "Metasystem - Reaper - In" under the MIDI port settings.
e Check the box in the Input column and then click "OK."

REAPER Preferences

neywva

MIDI hardware settings

Project MIDI inputs to make available (selectable as track inputs and/or learnable or action-bindable):

Backups Device Status Input All Control

Track/Send Defaults

Metasystem - Logic - In
Item Fade Defaults
Metasystem - MIDI - In

Metasystem - StudioOne - In

Item Loop Defaults
Audio

Device
Metasystem MCU
MIDI Devices
MIDI outputs to make available (selectable as track outputs):

Buffering

Device Status Enable

Mute/Solo

Playback Metasystem - Logic - Out

Scrub/Jog Metasystem - MIDI - Out

Seeking Metasystem - Reaper - Out

Recording Metasystem - StudioOne - Out

Loop/Lane Recording

Add virtual MIDL... Reset all MIDI devices

Rendering
Reset on:

Reset by: All-notes-off Pitch/sustain Play Stop/stopped seek

Annaaranra
MIDI input devices may be enabled for track inputs or for control messages oK
(which can be assigned in the actions list), or both

Find Cancel

Step 4. Enable Input for MIDI Messages (Optional):

e If you want to send MIDI notes, program change, and CC messages to Reaper
from Metapad, click on "Metasystem - MIDI - In" port and check the check box
in the Enable column.

REAPER Preferences

ey wua

MIDI hardware settings

Project MIDI inputs to make available (selectable as track inputs and/or learnable or action-bindable)

Backups Device Status Input All Control
Track/Send Defaults
Metasystem - Logic - In
Item Fade Defaults
Metasystem - MIDI - In
Item Loop Defaults
Metasystem - Reaper - In
Audio
Metasystem - StudioOne - In
Device
Metasystem MCU
MIDI Devices
MIDI! outputs to make available (selectable as track outputs)
Buffering

Status Enable Clock

Mute/Solo
Playback
Scrub/Jog
Seeking

Recording

Loop/Lane Recording

Rendering
Annasaranra

Find

MIDI output devices may be enabled, optionally with MIDI clock and SPP OK
sending. Reset messages can also be disabled

Device

Metasystem - Logic - Out

Metasystem - Reaper - Out

Metasystem - StudioOne - Out

Add virtual MIDI.. Reset all MIDI devices

Reset by: All-notes-off Pitch/sustain Reset on Play Stop/stopped seek

Cancel



Step 5. Open the Action List:

e Goto "Actions" and select "Show Action List."

Options  Actions Window Help [48kHz 24bit WAV : 1/2ch 512sp

v Show recent actions
Edit: Undo
Options: Preferences...
View: Show big clock window
View: Scale finder window
Media explorer: Show/hide media explorer
Track: Insert new track
Track: Remove tracks
Track: Insert new track at end of track list

Step 6. Import Custom Macros:

e Click the "Key map..." button within the Action List window.
e Next, click "Import shortcuts/custom actions, ignore other sections...."

Actions

Filter || Clear Options Find shortcut... Section: Main

Shortcut Description
Script: Default_6.0_theme_adjuster.lua
Script: lyrics.lua
Action: Arm next action
Action: Disarm action
Action: Modify MIDI CC/mousewheel:
Action: Modify MIDI CC/mousewheel:
Action: Modify MIDI CC/mousewheel:
Action: Modify MIDI CC/mousewheel: 2x
Action: Modify MIDI CC/mousewheel: Negative
Action: Momentarily send next action to next project tab 1
Action: Momentarily send next action to next project tab 2

Shortcuts for selected action
Key map... Menu editor.

New action

Import shortcuts/custom actions, import all sections
Import t actions, ignore other sections...
Import shortcuts/custom actions, map to this section...

Export shortcuts/custom actions for all sections...
Export shortcuts/custom actions for this section only...

Export selected shortcuts/custom actions...

Reset all shortcuts in all sections to defaults
Reset all shortcuts in this section to defaults
Remove all shortcuts from this section




Step 7. Locate the Metasystem Keymap File:

e Navigate to the location where you saved the app-specific resources for
Metasystem apps.
e Locate the "Metasystem keymap" file.

Step 8. Confirm Import:

e Click "OK" to import the file.

Actions

Filter Clear Options Find shortcut... Section: Main

Shortcut Description

MIDI Chan 14 CC O Custom: MG Macro 1
MIDI Chan 14 CC 1 Custom: MG Macro 2
MIDI Chan 14 CC 2 Custom: MG Macro 3
MIDI Chan 14 CC 3 Custom: MG Macro 4
MIDI Chan 14 CC 4 Custom: MG Macro 5
MIDI Chan 14 CC 5 Custom: MG Macro 6
MIDI Chan 14 CC 6 Custom: MG Macro 7
MIDI Chan 14 CC 7 Custom: MG Macro 8
MIDI Chan 14 CC 8 Custom: MG Macro 9
MIDI Chan 14 CC 9 Custom: MG Macro 10
MIDI Chan 14 CC 10 Custom: MG Macro 11

Shortcuts for selected action .
Key map... Menu editor...

MIDI Chan 14 CC 122 Add...

New action... Edit action... Delete

Delete
Run Run/close Close

Reaper's Action List will now contain 382 custom macros that you can tailor to your
specific needs.

Step 8: Tailor a custom action to your needs

e Select an action and Click Edit action...



Edit Custom Action

Filter: Custom action name: MG Macro 5

Custom: MG Macro 1 Action: Wait 0.1 seconds before next action
Custom: MG Macro 2

Custom: MG Macro 3

Custom: MG Macro 4

Custom: MG Macro 5

Custom: MG Macro 6

Custom: MG Macro 7

Custom: MG Macro 8

Custom: MG Macro 9

Custom: MG Macro 10 Consolidate undo points Remove action
Custom: MG Macro 11 Show in actions menu

V4 Show as active if all component actions are:
Custom: MG Macro 12 .

o Active Active or indeterminate

Custom: MG Macro 13

Custom: MG Macro 14 OK Cancel

e Our custom actions contain one action “Action.Wait 0.1 seconds before next
action”. This action has been added just as a placeholder. Remove this action
and drag any action from the left pane to the right pane.

More Information

MetaGrid Classic:

Reaper Setup Video Tutorial

Reaper Showcase Video Tutorial

Although these videos have been created for MetaGrid Classic, the basic concepts
and Reaper setup still apply to MetaGrid Pro.


https://youtu.be/Gex2UbI1238
https://youtu.be/FSCiUaKwUKo

ABLETON LIVE

Integrating MetaSystem apps with Ableton Live is a breeze with our Menu Command
action for Mac (MetaGrid Pro only) and the dedicated control surface device.

Menu Commands (Mac Only)

In MetaGrid Pro, our specialized ‘'Menu Commands' action gives you direct access to
every menu command in Ableton Live on Mac—no keyboard shortcuts needed.
Simply create a button, assign it a macro with the ‘'Menu Command' action, choose
the desired Menu and Command, and you're all set!

. Live - s »
L |
¥ My Grid for L ayout ne
MENU COMMAND (Live) Refresh
Category Command
Live Full Screen
File Second Window
Edit
Info
Create
Help View
View
. File Manager
Options
FED Toggle Arrangement/Session View .
-

Detail View
Toggle Clip/Device View
Expand Clip View

Arrange Clip View Panels Automatically

MIDI Note Editor
Envelopes Editor

Note Expression Editor

Browser

Groove Pool

Search in Browser

Control Surface

We have created a dedicated control surface enabling you to access useful features
in Ableton Live. Follow these easy steps to set it up:



Step 1. Download App-Specific Resources:

e First, download the App-Specific Resources from www.metasystem.io.

Step 2. Locate Ableton Live's Package Contents:

e On MAC, navigate to the Applications folder, find the Ableton Live icon, right-
click it, and select "Show Package Content."

e Within the opened Contents folder, go to App-Resources/MIDI Remote Scripts.

e On WINDOWS, the path is typically c:\ProgramData\Ableton\Live 9
Suite\Resources\MIDI Remote Scripts.

Step 3. Copy Metasystem Folder:

e Paste the "Ableton Live/Metasystem" folder from the downloaded App-
Specific Resources files into the MIDI Remote Scripts folder in Ableton Live's
package contents.

< MetaSystem

M _CodeSignature
@ App-Resources
I Frameworks
B Helpers

B Info.plist

8 LegalAndDocs
M Libraries

B MacOsS

B Pkginfo

I Push2

mQt

B Resources

I Builtin

[ Builtin Lessons
M Core Library
[ Database

M DefaultPackages
[ Defaults

W Devices

@ Extensions

B Fonts

—_ Graphics.alp
— GUlLalp

— Languages.alp
I Max

I MIDI Remote Scripts >
W Misc

I Python

@ Python2

[ Schema

B Templates

B Themes

| Versions

= [ 2 B2 b O O~ By Q
: ll::;r;chpad_x B _init_pyc
il B config.pyc

M LV2_LX2_LC2_LD2 B metasystem.pyc

I MackieControl

B MackieControl_Classic
B MackieControlXT

@ MasterControl

I MaxForLive
@ microkONTROL

B MidAir25

B MIDI_Mix

M MiniLab

B MiniLab_3

B MiniLab_mkll

W MPD18

I MPD24

i MPD32

I MPD218

m MPD226

I MPD232

B MPK_mini_mkl

B MPK_mini_mkll

B MPK_mini_mkill

Step 4. Configure MIDI Preferences in Ableton Live:

e Open Ableton Live and go to "Preferences."

Step 5. Access MIDI Settings:

e Inthe Preferences window, navigate to the "Link MIDI" section.

Step 6. Select Metasystem Device:



e Inthe MIDI section, find the MetaSystem device from the drop-down menu.

KX X Preferences

Look
Feel

Link

Show Link Toggle
Audio
Start Stop Sync

Link
Tempo
MIDI Show Tempo Follower Toggle

Tempo Follower

File Input Channel (Ext. In)

Folder MIDI

Library Control Surface

lone
Plug-Ins Launchkey MK2
Launchkey MK3
Launchpad
Launchpad Mini MK3

Launchpad MK2 None (

Licenses Launchpad Pro

Record
Warp
Launch

Maintenance Launchpad Pro MK3
Launchpad X

LPD8 Track Sync Remote
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MackieControl

=
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MackieControl Classic
MackieControlXT
MasterControl
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MetaSystem
microKONTROL
MidAir25
MIDI Mix
MiniLab
MiniLab 3
MiniLab mkll
MPD18
MPD24
MPD32

<

I
IO OO

[

A RS NS
INEEEEEEEEES

|
]

Step 7. Assign MIDI Ports:

e Assign the "Metasystem - Ableton Live - In" and "Metasystem - Ableton Live -
Out" ports to the Input and Output columns, respectively.

Step 8. Enable MIDI for App-Specific Actions (Optional):

e If you want to receive MIDI from MetaSystem apps to assign note and CC
messages to Ableton Live's interface elements, enable the "Track" and
"Remote" buttons next to "Metasystem - MIDI - In" and "Metasystem - MIDI -
Out" ports.
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MIDI Show Tempo Follower Toggle
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Dorico

You can access all of Dorico's commands in MetaGrid Pro by following one of two
methods:

Method 1: Dedicated Support via JSON File
Step 1: Locate the Key Commands JSON File:

On your Mac, go to the Applications folder and find Dorico.

Right-click on Dorico and select "Open Package Contents."

Inside the package contents, navigate to Contents > Resources.

Look for the key commands JSON file; its name may vary depending on your
computer's language, but for English, it's typically named
"keycommands_en.json."

e On you Windows computer, locate the json file using the search functionality.
Step 2: Copy the JSON File:

e Copy the key commands JSON file to a dedicated folder on your computer.
You can create a new folder specifically for MetaServer released files.

Step 3: Configure MetaServer:

e Open MetaServer and go to the "Files" section.
e Specify the file path for the Dorico key commands JSON file that you copied in
the previous step.

Step 4: Restart MetaServer and MetaGrid:

e After configuring MetaServer, restart both MetaServer and MetaGrid to apply
the changes.

Now, you'll have access to Dorico's full command set through app-specific actions in
MetaGrid Pro.

Method 2: Using the Menu Commands Action

If you're on a Mac and want access to all Dorico commands while creating your
custom grids, you can use the Menu Command action. This action provides access
to ALL menu commands in Dorico, including those without keyboard shortcuts.

With these two methods, you can seamlessly integrate Dorico's commands into your
MetaGrid Pro setup, enhancing your control and workflow efficiency. Enjoy the
freedom to customize and streamline your tasks in Dorico with ease.



	Table of Contents
	INTRODUCTION
	To set up integration with your DAW, follow these steps:
	For Mac Users:
	For Windows Users:

	Menu Command Action

	Logic Pro
	Logic Pro Commands
	MIDI Transformer Sets for Logic Pro (Premium Feature)
	Art Conductor Integration

	CUBASE/NUENDO
	Importing XML files to enable app-specific commands and control.
	Creating Generic Remote Devices:
	Avoiding MIDI Feedback:

	LE Macros
	Setting Up LE Macros from App Specific Resources
	Assigning an LE Macro to a Button:
	Ensuring Consistency Between Generic Remote and App-Specific Commands

	Scene PLE Macros
	Setting Up PLE Macros from App Specific Resources
	Customizing Scene Macros

	More information
	MetaGrid Classic:
	MetaGrid Classic:


	Studio One
	Menu Commands (Mac Only)
	Custom User Device
	Access Support Files:
	Copy Support Files:
	Configure Studio One:

	More information:
	MetaGrid Pro:
	MetaGrid Classic:


	Digital Performer
	Menu Commands (Mac Only)
	Custom Integration
	Locating Key Bindings File:
	Importing Key Bindings in DP:
	Using Layouts:
	Checking MIDI Masters:

	More Information
	MetaGrid Classic:


	Reaper
	Menu Commands (Mac Only)
	Custom Actions
	More Information
	MetaGrid Classic:


	Ableton Live
	Menu Commands (Mac Only)
	Control Surface
	Dorico
	Method 1: Dedicated Support via JSON File
	Method 2: Using the Menu Commands Action



